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Lab #4 — The User Interface

The objective of this lab Is to introduce you to the
switchboards in Access.

The switchboard manager is the component of Access which
deals with the user interface, i.e., the design of a switchboard.

While you are becoming a proficient user of/and
knowledgeable in the organization of Access, many potential
users of the databases that you will develop are not.

The user interface ties the various database objects together in
such a manner that the database is easy to use for even a non-
skilled user.

NOTE: In the slides that follow, if the call-out symbol is
outlined in red, it means that there is something for you to try, if
the call-out is outlined in blue, | am simply giving you some
information about what is displayed on that page.
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Lab #4 — The User Interface

The switchboard manager is an Access utility that prompts you for information
about each menu that you will include in your switchboard design.

To remember what a basic switchboard looks like, start the Northwind sample
database and you will see the switchboard as shown below.

m\\H 9 - ™ = Microsoft Access
.E%, =

‘ Home | Create External Data Database Tools

iE = 2 4 [8]=
EL I [EREAS S0 -c ==

A
|§E = ||ai3/ | Records| Filter Sizeto  Switch
z = =7 ' Fit Form Windows ~

Rich Text Sort & Filter Window

Al pecess Objecs - . _~ | The Northwind sample
— database switchboard

“Wiew Product and Order Information:

Frirt Sales Beports

I Display Database Windaw
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Creating A Switchboard

* Since the switchboard provides a user with the
ability to manipulate various objects in the
database from a high-level perspective, it is
required that you create a switchboard on an
already created database. Preferably one with
queries, forms, reports, and possibly other
objects defined.

| would suggest that you look at the definitions
for the switchboard that Is defined In the
Northwind sample database first, before you
continue with this lab.

’
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Creating A Switchboard

Having looked at the Northwind switchboard, lets
now move on and create our own switchboard.

To do this, download the suppliers-parts-
jobs-shipments database from either the course

website or the lab section (Lab 4) on WebCourses.

This fairly simple database has been created with a
couple of queries, forms and reports already set-up so
that we have something to put on our switchboard.

Once you download this database, open it in Access
and you should see the following screen.

’
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The Suppliers-Parts-Jobs-Shipments Database

|  suppliers-parts-jobs-shipments : Database (Access 2002 - 2003 file format) - Microsoft Access -~ = X

External Data Database Tools @

S =20 e ~

T LB B A
“alyﬂ Records Filter Sizeto  Switch ‘ Find
= 7 W || Fit Form Windows~ | W

H |
Views | |Clipboard & || Font | RichTet | | Sota&Fiter ||  Window |  Find

- v

All Access Objects
Tables

=3 Jobs

&3 Parts

E Shipments
E Suppliers

Its possible that “All
Access Objects” will
not be the default
here. If so, click the
down-arrow icon to list
all options and select
“All Access Obijects”.

Queries N

@ Supplier names who ship par...
@ Supplier names with shipmen...
@ Supplier names with shipmen...

Forms N
@ Parts

@ Shipments

@ Suppliers

Reports 2
Suppliers and Shipment Qua...

Ready
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Starting The Switchboard Manager

Click the Database Tools tab.
In the Database Tools group, click Switchboard Manager.

Click Yes if you see a message indicating that there is no valid
switchboard and asking if you want to create one.

You should then see the Switchboard Manager dialog box (See page
10).

The sequence of slides on the next few pages illustrates this
sequence of operations.

#
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Click the Database Tools tab.
/ Then click Switchboard Manager

In Database Tools group.

e ¥ - M- |5 suppliers-parts-jobs-shipments : D ase (Access 2(

Home Create External Data I Database Tools l / (7
a2y = _é % Property Sheet B =g @gi Iﬁ%?‘ ‘@'A({/ﬁ | @.
[l58 iR | = ZZ Object Dependencies | = || 9.0 =~ FERR g3~
Vlsqal e Relationships ‘ < | Encode/Decode Linked Table . Make ‘
| Basic «ij‘ LI Message Bar ‘ 4 Il | Database Manager &8~ MDE || {
_ Maco | Show/Hide. || Analyze! | Move Data Database Tools Administer
All Access Objects v o« Switchboard Manager
Tables XA
= Jobs ]
=3 Parts
= Shipments
= Suppliers
Queries A
@ Supplier names who ship ...
E.-I Supplier names with ship... =
B.-l Supplier names with ship...
Forms A
@ Parts
@ Shipments
@ Suppliers
Reports a2 o
_ Suppliers and Shipment Q... ¥
Ready Num Lock [ﬂ
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Starting The Switchboard Manager

| (\J. )

v

Create

suppliers-parts-jobs-shipments : Database (Access 2002 - 2003 file format) - Microsoft Acc...
External Data

% Property Sheet

| Database Tools |

= X

o)

ﬁé

E*
-~ || Relationships

%3] Object Dependencies

Encode/Decode Linked Table
| | Message Bar

A

Show/Hide

Analyze | Move Data

Database

Manager

Database Tools

All Access Objects

Switchboard Manager

Tables
Jobs

Parts
Shipments
Suppliers

Switchboard Manager

Queries

N
A

@ Supplier names who ship ...
@ Supplier names with ship...
@ Supplier names with ship...

Forms S
@ Parts

@ Shipments

@ Suppliers

Click Yes.

Reports

Suppliers and Shipment Q... ¥

Ready

Num Lock
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The Switchboard Manager Dialog Box

7

e
: Home

)i 9 & )

Create

5

External Data

| Database Tools |

; iy
Visual .
Basic

Macro

All Access Objects

Tables
Jobs

Parts
Shipments
Suppliers
Switchboard Iter

a.

Supplier names \

Supplier names \

@ Property Sheet

%) Object Dependencies
Relationships S

DOar i

Switchboard Pages:

Ué

Microsoft Access
e G W | pg

A =
i FoI .
Encode/Decode Linked Table . Make

T MDE
Administer

Click the Edit button

Delete

Make Defaulk

W& & EE A

Supplier names v

Forms

=] Jobs

5| Parts

@ Shipments
@ Suppliers

] itchhoard

Ready

Num Lock
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The Switchboard Manager Dialog Box

7

Do) lid 9 Mz )= Microsoft Access
1\ [ eq ¥ = [ ,
> Home Create External Data | Database Tools |

= [%f Property Sheet 32 g o

=25 it ¥Z]
73 Object Dependencies = -

Relationships : - e Encode/Decode Linked Table

Administer

- - Edit Switchboard Page
All Access Objects

Tables Switchboard Mame:
Jobs Main Switchboard Click the New button to
Parts Items on this Switchboard: add an item to this page,
Shipments — which in turn displays
Suppliers Edi.. the Edit Switchboard
Switchboard Iten Delete item dialog box (next
slide).

a.

Supplier names Morve Up

Supplier names

Move Down

R

Supplier names ¢

'dg
sé

il
00|

Parts

Shipments

Suppliers

B

Switchbhoard
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The Switchboard Manager Dialog Box

7

On)\id 9 ™ s Microsoft Access
— Home Create External Data \ Database Tools |
= % Property Sheet F=
E* é %) Object Dependencies

Visual .. | Relationships
Basic —
Macro Administer
All Access Objects
Tables

Jobs

You are now ready to
begin adding object to
the switchboard.

Parts Texk: levy Swikchboard Command

Shipments | ommand: 50 ko Switchboard

Suppliers

Switchboard: |

Switchboar

a.

Mowve L
Supplier names \ =

Supplier names \ Move Down

e

Supplier names

T
§§

Parts

Shipments
Suppliers

@

Switchhoard

Num Lock H
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The Switchboard Manager Dialog Box

(D i e v 5 Microsoft Access - = X

>

e { ] 7
- Home Create External Data | Database Tools | '@

E‘@ 7 Property Sheet E ¥ == G A Put the cursor in the

- 7 Object Dependencies | = S ! < | Text list box and type
Relationships - = “ :

e = Add supplier
information.” which is
the name of the
command as it will
appear on the
Texk: Jew Swikchboard Command el SWltChboard .

4 Shipments
" Command; |G|:| ko Swikchbioard

4 Suppliers

Switchboard: |

4 Switchboarg

Move Up

Move Down
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The Switchboard Manager Dialog Box

7

On)\id 9 ™ s Microsoft Access
\ La' -

Home Create External Data \ Database Tools |

ij% % Property Sheet £

E* %) Object Dependencies
Visual .. | Relationships
Basic —

Macro

Edit Switchboard Page
All Access Objects

Tables
58 [ dit Switchboard Item

Switchboard Mame:

Text: |.ﬁ.|:||:| supplier information

50 bo Swikchboard
o ko Swikchboard
Cpen Form in Add Mode

Command;

I

Switchboard:

Open Form in Edit Mode <—

T
;

Supplier names \

Supplier names \

i Gh

Supplier names

173
Eé

Parts

Shipments
Suppliers

@

Switchhoard

Move Up

Move Down

- HX

@

| Click the drop-down

| arrow on the Command
list box and choose the
command to Open the
Form in either the Add
or Edit mode.

Num Lock H
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The Switchboard Manager Dialog Box

#

( na A ) (u
e Ej

Home Create

s &y

_LI’
Visual . . || Relationships

-~

Basic
Macro

All Access Objects

Tables

Texk:

Command;

Forrmn:

v

External Data

_34“33 % Property Sheet
== -
7] Object Dependencies =~ =4

Edit Switchboard Page

Switchboard Mame:

E= [ dit Switchboard Item

k-

Microsoft Access

| Database Tools |

|.ﬁ.|:||:| supplier information

|O|:|en Faorrm in Edit Mode

upplicr|

ries
Supplier names \

Supplier names \

iy Ly']’g Bl B ER B

Supplier names

-
[~}

rms

E Parts

:_;EI Shipments
EI Suppliers

'=I Switchhoard

Click the drop-down
arrow on the Form list
box and choose the
Suppliers form
(previously created in this
database).

Then click OK to create
the switchboard item. The
Edit Switchboard Item
dialog box closes, and
then the item appears in
the Main Switchboard
page as shown on the
next slide.

Ready

Num Lock | &
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The Switchboard Manager Dialog Box

>

Microsoft Access

( na A ) (u —
[t~ ‘
Home Create External Data Database Tools ©

o 2y = %f Property Sheet EX =y odn]
= — ShS 11410
% (b IS | 017 00

%) Object Dependencies =~ =9 wr

{ The newly created
; switchboard item.

Visual _I Relationships
Basic ==
Macro Switchboard Manager,

All Access Objects

¥

Edit Switchboard Page

Switchboard Mame:

Main Switchboard

Click the New button and
continue to add additional
forms to the switchboard.

Items on this Switchboard:
Shipments

Suppliers Edi... On the next screen the

switchboard is shown after
all of the available forms
Mave Up and the report have been
added to the switchboard.

Switchboard It

Delete

e
@

Supplier nameg

Supplier nameg

Movwve Down
Supplier nameg

@ P EEE

3

3
Jobs

Parts
Shipments
Suppliers

Switchbhoard

| Ready
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The Switchboard Manager Dialog Box

(D i D M S Microsoft Access i s
way 00

Home Create External Data | Database Tools ] '@
= [%F Property Sheet £ =5 m I’D ) j;;f The new switchboard.
= 11410 #u Vaui
E% %] Object Dependencies e n2 —jj e
e =

Relationships - [ . wake| Click close to exit the
s : MDE

>

Encode/Decode Linked Table

switchboard editing
window.

Switchboard Mame:

|Main Switchboard

Trems on this Switchboard:

Shipments : &dd supplier information
&dd Part information Edit. ..
&dd Job infarmation =

Switchboard itd | &dd information on Shipments
Suppliers and Shipment quantities Delete

Suppliers

Queries

@ Supplier names Move Up

‘ﬁ Supplier names|

. Mowve Down
“ﬂ Supplier names| =

Forms
Jobs

Parts
Shipments

Suppliers

Switchhaoard
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The Switchboard Manager Dialog Box

>

(Ca ;ﬂ ) - (M s Microsoft Access

Home Create External Data | Database Tools |
_ /=[5 Property Sheet R | 5 & -~ Upon returning to the
=55 ZObject Dependencies | S | i - 5 | Switchboard Manager
s ‘ window, you have a couple
2eangmanase of options. You can set the
Switchboard Pages: neW|y created switchboard
to be the default now (or
you can wait and do it
later...your choice).

Relationships

4 Shipments
| selected Make Default

now.

4 Suppliers
1 Switchboard Iten]

Queries Make Default Then click Close and

= Ssupplier names v restore the main database
'@ Supplier names y WindOW.

@ Supplier names y

Forms
“=] Jobs

CE] Parts

E Shipments
E Suppliers

‘."ﬂl Switchhaoard

L Ready
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The Switchboard Manager

External Data

% Property Sheet

7 Object Dependencies

Relationships
| | Message Bar

Show/Hide

Home Create

=
Visual .
Basic
Macro ||

| Database Tools |

&

| Analyze | Move Data

Database

Encode/Decode Linked Table

Manager
Database Tools

Administer |

All Access Objects

—_

Tarey

& Shipments
& Suppliers
T switchboard Items

Queries X
@ Supplier names who ship ...
@ Supplier names with ship...

@ Supplier names with ship...

X

Shipments
Suppliers
Reports
{8 suppliers and Shipment Q... +

1

Upon returning to the main database
window, select Forms from the objects
list and you will see the new
Switchboard listed among the various
forms.

Double-click the Switchboard form to
activate it...don’t worry too much about
its current format, you can always
change it. Right now we just want to
test the features available from the
switchboard.

Ready
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The Switchboard Manager

o f Sl = I
I'-E% o9 Microsoft Access - = X

Home Create External Diata Database Tools

) The switchboard is now active. Click
b .@ = f Property Sheet = i | | on any of the buttons to perform the
ik - = ﬂ Object Dependencies % E Eﬁg PLe y p

Visual __, || Relationships - Encode/Decode Linked Table SpeC|f|ed action.
Basic Message Bar e Database Manager

Macro Show,/Hide Analyze | Move Data Database Tools Administer /

All Access Objects -

jme——|

5] Main Switchboard

j Shipments : : /
B suppliers suppliers-parts-jobs-shipme

j Switchboard Items

Queries b3

Add supplier information
D Add Part information

@ Supplier names who ship ...
@ Supplier names with ship...
@ Supplier names with ship... D Add Job information

Forms = D Add information on Shipments
lobs

D Suppliers and Shipment quantities
Parts
Shipments
Suppliers

Switchboard

o
e

= | Suppliers and Shipment Q..

| Form View Mum Lock  Filtered HEI--@-@-E[-EE'
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The Switchboard Manager

- )+ microsoft Acces| After clicking on the Add Suppliers information
Home  Create  ExternalData | Database Tools button, the Suppliers form is activated. Note
- i_{j AR property Sheet 2 =5 that since we selected the Open in Edit Mode
B 23 object Dependencies || I N for our Switchboard command, we can edit any

Message Bar = 1 record in the Suppliers table. This means that

Macro Show/Hide Analyze| | Move Data the default opening places you at the top of the
All Access Objects v « = table, to insert a new record move to the bottom
= e - of the table using the directional buttons on the
form.

Relationships

'j Shipments

'j Suppliers

'j Switchboard tems s
3] suppliers

Queries b3

4
'@ Supplier names who ship ... snnm sname
Mark

'@ Supplier names with ship...

. M [ T A
'@ Supplier names with ship... |Recnrd D | ot | SEalEl

Forms * E] Add information on Shipments
=l lobs E] Suppliers and Shipment quantities
Parts
Shipments
Suppliers

Switchboard

Reports b3
Eﬂ Suppliers and Shipment Q... *
Form View Mum Lock UEI gh | i | ET Eb
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Assessment Point #1

At this point, be sure that all of your buttons on the
switchboard do what you wanted them to do and go
back and modify any that don’t perform the action
you want.

« For example, maybe you really wanted the user to
only be able to add new suppliers and not to be able
to modify existing rows in the table. Then reset the
Command mode to Open in Add Mode rather than
the Open in Edit Mode we used. Try It.

 Once you’re comfortable with your switchboard,
move on and we’ll add an icon to It to jazz it up a bit.

’
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The Switchboard Manager

With the switchboard active switch to
the Design view (either from Views
group in Home tab —or- on command
tray at the bottom of the screen).
Maximize the view so you have room

Views ||Clipboard ™= Rich Text to work.

- ) 3| = ;
( E% ™ ¢ Microsoft Access
Home Create External Data Database Tools

4
=)

+— . —

R bl B
s |

[§= i=||3%8* - || |Records

M

All Access Objects
L] Farts

:j Shipments
:j Suppliers
:j Switchboard Items

@ Main Switchboard

suppliers-parts-jobs-shipms

Queries £ Add supplier information
@ Supplier names who ship ...

(] AddPartinformation
@ Supplier names with ship...

@ Supplier names with ship... D Add Jobinformation
Forms # E] Add information on Shipments

=5] Jobs E] Suppliers and Shipment quantities

Parts
Shipments
Suppliers
Switchboard

ports S

ﬁﬂ Suppliers and shipment ...
Form Wiew Mum Lock  Filtered HEI--@-@,-EE-
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In Design tab, Click on Image button

,-Eg AR EE——— moesion| Move cursor to the left side of the switchboard in the large
Home  Create  ExternalData  Database Tools =ion | green shaded area (the cursor should change to a little
0= (A ) &l B # = § black plus with image box)

. e (T R @M DS S | |
View || Font | Grdines | logo = | o g Draw a box where you want your picture to display. The

- - =
—

Views Gridlines Controls dialog box to appear for you to choose the image on your
All Access Objects T ¢ N =3 switchboard SyStem.

o

¥ Detail

Shipments : suppliers-parts-jobs-shipments
Suppliers :

Switchboard Items

=

'@ Supplier names who ship par...

'@ Supplier names with shipmen...

'@ Supplier names with shipmen...

Forms *

Jobs

Parts

Shipments

Suppliers

Switchboard

%

Suppliers and Shipment Qua...

[

Mum Lock IJE £ it ET M;

Design View
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"

i - e
il w3 lg 9
T |

=S

View

-

Views

Home Create

A

Font || Gridlines

-

Gridlines

Microsoft Access Once you selected your picture click OK and it should drop

External Data  Database Tools into the area some where. Use the cursor to move it

[ ] B |abl B\ [ = around and resize it until you get it where you want it.
. q | ACEC & [ Then return to the normal view.

All Access Objects

’ SITTEATITTTYTTT L3 —
' : Fields eet
Controls Tools
5] switchboard

Tables

lobs

Parts
Shipments
Suppliers

Switchboard Items

o

Queries

'@ Supplier names who ship par...
'@ Supplier names with shipmen...

'@ Supplier names with shipmen...

S
oy

Forms

-=| Jobs

Parts

Shipments
Suppliers
Switchboard

=

Reports

Suppliers and Shipment Cua...

=

Design View
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r.ﬁ' H9-o-)s | Voila! Your switchboard is done. You can do a lot of
’ .‘E customization of switchboards in Access, including major
layout changes and button formats. All of this can be

i 5 =/ /| accomplished in the design view of the switchboard.
=2 |||B I O||E = F — =
1] = ||ab= Records Filter Size to Switch Find
7 l|A ]2 |HEH = = (LSl G| B 5 W || Fit Form Windows ~
Views ||Clipboard ™ Font Rich Text Sort & Filter Window Find

Home Create External Data Database Tools

Paste

All Access Objects
Tables
lobs

suppliers-parts-jobs-shipments

Parts
Shipments

suppliers b ; SR Add supplier information

switchboard Items E] Add Part information

Queries #
(] Add Job information
'ﬁj Supplier names who ship par...

'ﬁj Supplier names with shipmen... " L D Add information on Shipments

'ﬁj supplier names with shipmen... e e e e D Suppliers and Shipment guantities
Forms b

Jobs

Parts

Suppliers

=
E
% Shipments
=
5]

Switchboard

Reports &
E Suppliers and Shipment Cua...

W

Form WView Mum Lock  Filtered UEI i it | EF Mb
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=9 - o s Microsoft Access Form Design Tools

Home Create External Data Database Tools Design Arrange
EX3 L 1=l
A H|ablEBND 2 dbS g
| - = || TR | Al BT MEE® | = 5 ada Bxisting Property 2
on Gridlines ogo — e isting Prope
- = B =aEEe =@ e Fields  Sheet L

Gridlines Controls Tools

5] switchboard

[

|| # Detail

| Many of the advanced features for designing the layouts
< are available under the Design tab. You can experiment
| with some of these features if you'd like.

Mavigation Pane

3 1 F
- B ML - 254 b

| Design View - .I;nl.uml.u-:k ulﬁl--ﬁ-@uﬁ[-ﬁg
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Lab Assignment #4

Lab Assignment #4 — Due October 12 by 11:55 pm (WebCourses time) — 25
points

Create a new (different from the one we just created in this lab) switchboard
for the suppliers-parts database using the Switchboard manager.

Use the same cut and paste method as in previous labs for your submission.
Just take a “picture” of your finished switchboard.

NOTE: Please use the following naming convention for your uploaded files:

HWO04 LastNameFirstName.doc or
HWO04 LastNameFirstName.pdf
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